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Introduction 
This Computer Lane Monitor for Windows User Guide is intended to teach you how to 
use the Computer Lane Monitor for Windows program.  Much of this guide assumes you 
have a thorough understanding of how to use your lane optical reader and recorder. 

If you are not already familiar with the lane optical reader and recorder, refer to the main 
Operator Manual part number 61-900017-000 pages 1 to 13.  Pages 31 through 42 of the 
same manual covers the troubleshooting and service of the lane optical reader and 
recorder. 

The Computer Lane Monitor for Windows program requires Windows 3.1 or higher, 
including Windows 95, an IBM compatible, 386 or higher computer with a minimum of 4 
Megabytes of RAM and a VGA color or monochrome monitor to control the optical reader 
and display the information.  Since the software also stores the tape files in a database 
for quick retrieval, a hard drive is also required.  The software program must be installed 
onto the computer before the initial operation of the Computer Lane Monitor. 

The Computer Lane Monitor for Windows program, along with an optical reader, allows 
you to read and record the amount of oil present on a lane surface from a tape sample.  
You can use this program to perform several tasks: 

• Read tapes 

• Store tape readings 

• View stored tape data in several graphical formats and print them 

Windows Basics 
This guide does not teach you how to use Microsoft Windows.  This guide assumes you 
know how to use basic Windows components—dialog boxes, check boxes, buttons, the 
mouse and pointer, and the cursor.  These things are common to all Windows 
programs.  Please refer to your Windows documentation or the Help menu that is 
available from Window’s Program Manager for help using Windows.  If you are not 
familiar with basic Computer Lane Monitor components, refer to the main Operator 
Manual part number 61-900017-000 which explains the DOS version of the Computer 
Lane Monitor program. 
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Installation of Computer Lane Monitor for Windows Software 
Complete the following steps to install the Computer Lane Monitor for Windows program. 

Note: It is suggested that a copy of the original installation diskettes be made and kept in 
a safe location.  

Installing Computer Lane Monitor for Windows  
1. Start Windows. 

2. Insert Computer Lane Monitor for Windows disk 1 in drive A or B. 

3. From the File menu on the Program Manager window, select Run. The Run dialog 
box is displayed. 

 

4. In the Command Line field, type a:\setup or b:\setup, and click OK. The Computer 
Lane Monitor for Windows Setup dialog box is displayed.  Click Continue when the 
welcome prompt with the version number is displayed. 

5. In the Install To field, type the directory in which you want to install Computer Lane 
Monitor for Windows, and click Continue.  To accept the default C:\ CLMWIN 
directory, click Continue. 

 

6. When the “Please insert disk #2” message is displayed, insert disk 2, and click OK. 

The installation process is complete when the Computer Lane Monitor Successfully 
Installed dialog box is displayed.  At this time, the setup program will need to restart 
Windows.  You should close any DOS or other Windows applications you are running, 
by using the Alt+Tab keys or the task manager. 

If you are running Windows in standard mode, rather than 386 enhanced mode, you will 
be prompted to add the following line to your autoexec.bat file: 

 Share.exe /L:500 
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Share.exe is a DOS utility program that is included with your DOS operating system 
software.  For more information about Share.exe, see the DOS documentation that 
came with your computer. 

After adding share.exe to your autoexec.bat file, you must then restart your computer. 

Computer Lane Monitor for Windows Basics 
Computer Lane Monitor for Windows is a program that allows you to read tapes, store 
tape data, view tape data in various graphical formats, and print the graphs. 

A status bar is located in the lower left corner of the display screen.  The normal 
progression of reader status is from “Tape Reader Connected” to “Firmware: PC Lane 
Monitor Version 3.00” to “U.V. Bulb ON” to an automatic warm-up check.  After the 
reader warm-up check is completed, the task buttons are normally selected in order 
from left to right, i.e. first Calibrate, then enter Tape Header information, then Read 
Tape, and so on through all the buttons. 

Each time a tape sample is read, the information can be stored as a tape data record in 
the current database.  The tape header information helps identify each tape data record 
for selection when viewing graphs or manipulating files. 

You complete Computer Lane Monitor for Windows tasks with buttons or menu 
commands that are available in the Computer Lane Monitor for Windows window. 

Buttons 
There are five buttons you use to complete the most common Computer Lane Monitor 
for Windows tasks. 

  Calibrate—This button allows you to calibrate an optical tape reader with a 
calibration strip of a known value.  You must calibrate before you can read a tape.  
When you select this button, dialog boxes walk you through the calibration process. 

  Tape Header—This button allows you to enter tape header information.  
This information helps identify each tape data record and is displayed when you view 
tape data records in graphical formats. 

  Read Tape—This button allows you to begin the tape reading process.  
When you select this button, you are prompted to insert the tape you want to read in the 
optical reader and Computer Lane Monitor for Windows displays the reading in a  
2-D tape graph as the tape is being read.  The status bar in the lower left corner of the 
display prompts the Read Tape process along with the dialog boxes. 
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  2-D Tape Graph—This button allows you to view stored tape data 
records in a 2-D tape graph.  You can view up to five tape data records at a time with 
this graph.  This graph displays the amount of oil detected on individual tape samples. 

  3-D Lane Graph—This button allows you to view tape data records in 3-
D formats.  These formats display the way oil was distributed on a lane as it was 
sampled from multiple tape data records.  You can select to view data in four different 
graphical formats.  You use the 3-D lane graphs to view how oil was distributed at 
different distances on the same lane. 

Menus 
You can also use menu commands to complete Computer Lane Monitor for Windows 
tasks.  Some of the menu commands have an equivalent button.  It does not matter if 
you use the menu command or button to complete the task. 

You can find the menus at the top of the Computer Lane Monitor for Windows window 
as shown in the following illustration. 

 

File Menu 
There are five menu commands from the File menu: 

New Graph—This menu command has two options that allow you to view stored 
tape data records in a 2-D tape graph or 3-D lane graph. 

• Tape Graph 
Use this command to view stored tape data in a 2-D tape graph.  This menu 
command option allows you to complete the same task that the 2-D Tape Graph 
button allows you to complete. 

• Lane Graph 
Use this command to view stored tape data in a 3-D lane graph. This menu 
command option allows you to complete the same task that the 3-D Tape Graph 
button allows you to complete. 

Close Graph—This menu command allows you to close 2-D tape, 3-D lane, or 
current Tape Read graphs that you have open.  This command is available only 
when you have a graph open. 
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Database—This menu command has several options that allow you to create and 
manage database files in which you store tape data records.  You do not have to use 
these menu commands to successfully use Computer Lane Monitor for Windows.   

With these commands, you can create or delete database files for use with 
Computer Lane Monitor for Windows.  You can also copy or delete records in 
database files. 

Note: If you do not change the file extension or path, your tape data records are 
automatically stored in the Computer Lane Monitor for Windows default 
database file. (C:\CLMWIN\SAMPLES.MDB) 

• Select Database  
Use this command to select the database file that contains the tape data 
records that you want to view or the database file in which you want to store 
new tape data records.  You can select only one database file at a time from the 
list of existing databases.  If you do not use this command to select a database 
file, Computer Lane Monitor for Windows opens its default database file.  The 
default database file is the easiest file to use to manage your tape data records. 

• Create New Database 
Use this command to create a new database file in which you want to store tape 
data records. 

• Delete Database 
Use this command to remove an old database file for which you no longer want to 
view its tape data record data.  All the tape data records in the database file are 
deleted. 

• Copy Records 
Use this command to copy tape data records from one database to another. 

• Delete Records 
Use this command to remove a tape data record from a database file. 

• Repair Database 
Use this command to restore a database file should it become corrupted. 

• Import DOS Data 
Use this command to import, or transfer, data from an existing DOS database 
into a Computer Lane Monitor for Windows database file. 

Print Setup—This menu command allows you to set up how you want to print data. 
It is a standard Windows menu command.  For more information about this menu 
command, see your Windows user guide. 

Exit—This menu command allows you to close the Computer Lane Monitor for 
Windows program. 
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Tape Reader Menu 
There are four menu commands from the Tape Reader menu: 

Warmup—This menu command has two warm-up process options: Bypass and 
Restart.  You should make sure that your optical reader has been on for at least 30 
minutes before you calibrate or read tapes.  Otherwise, you might have to recalibrate 
frequently until the optical reader is warmed up.  The warm-up process ensures that 
the optical reader is ready to be calibrated and read tapes. 

• Bypass  
Use this command to bypass the warm-up process.  If you bypass this process 
and the optical reader is not warm, you may have to recalibrate more frequently. 

• Restart 
Use this command to manually restart the warm-up process if the automatic 
warm-up process that is run when you first start Computer Lane Monitor for 
Windows was bypassed or was not successful. 

Calibrate—This menu command has two options that allow you to calibrate your 
optical reader and Computer Lane Monitor for Windows.  These menu commands 
work the same as the Calibrate button. 

• Short 
Use this command if you want to calibrate your optical reader with only one 
calibration strip. 

• Standard 
Use this command if you want to calibrate your optical reader with three 
calibration strips. 

Note: The first time you run the Computer Lane Monitor for Windows program 
you must use the standard calibration.  After that, you can use the short 
calibration.  The program automatically prompts you when you must use 
the standard calibration again. 

Tape Header— This menu command allows you to enter tape header information 
for the current tape read graph.  This information helps identify each tape data 
record and is displayed when you view tape data records in graphical formats. This 
menu command works the same as the Tape Header button. 

Read Tape—This menu comand allows you to start the tape data record process. 
This menu command works the same as the Read Tape button. 

• Automatic 
Use this command if you want the optical reader to automatically control the 
tape when you read a sample tape. 

• Manual 
Use this command if you want to manually control the tape through the optical 
reader when you read a sample tape.  After the tape is positioned on the start of 
the second board, this process is identical to the automatic read tape process. 

Move Tape—This menu command allows you to manually advance a tape through 
an optical reader.  You can use this command to clear tape samples from the optical 
reader if the automatic tape feed was halted. 
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Configure Menu 
There are four menu commands from the Configure menu: 

Advanced Setting—This menu command allows you to configure special 
parameters for an optical reader.  This command sould only be used for specific 
diagnostic purposes under the direction of a qualified Brunswick representative.  
Changing the settings can reduce the accuracy of the calculated tape values.  Use 
the “Default” button in the lower right corner of the dialog box to reset all variables to 
their original values if you suspect any have accidentally been changed.  

Communications—This menu command allows you to set up the communication 
(COMM) port in which an optical reader is plugged in your computer. 

Hide Button Bar—This menu command allows you to remove the button bar from 
the Computer Lane Monitor for Windows window.  When you select this command, 
the button bar disappears and this menu command changes to Show Button Bar.  
Select the Show Button Bar command to display the button bar. 

Window Menu 
The commands available from the Window menu are standard Microsoft Windows menu 
commands.  Please refer to your Windows documentation or the Help menu that is 
available from Window’s Program Manager for additional help using these menu 
commands. 

Window—This menu allows you to select to view any active Current Tape Read 
graph, 2-D Tape graph, or 3-D Lane graph.   

Tile and Cascade—The Tile and Cascade options are normal Windows commands. 

Help Menu 
The commands available from the Help menu are standard Microsoft Windows menu 
commands.  Please refer to your Windows documentation or the Help menu that is 
available from Window’s Program Manager for additional help using these menu 
commands. 

There are three menu commands from the Help menu: 

Contents—This menu command allows you to select different reference sections 
from the Operator Manual.  One of the key sections is the Troubleshooting section 
which could quickly identify the cause and solution to a problem. 

Search for Help on—This menu command allows you to search through a list of 
key phrases or type in a key word.  The system then searches for related topics and 
allows you to go to the reference section of the selected topic. 

About CLMWIN—This menu command displays the software version and Tape 
Reader Firmware version. 
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Installing and Getting Started 
This section provides instructions on how to install the Computer Lane Monitor for 
Windows program and the optical reader cables.  It also includes instructions for how to 
start the Computer Lane Monitor for Windows program. 

Connection of Optical Reader Cables 
Complete the following steps to connect your optical reader to your computer.  Be sure 
that the computer on which you use Computer Lane Monitor for Windows is turned off 
when you connect your optical reader. 

Connecting optical reader cables 
1. Plug the male end of the optical reader’s serial computer data cable into the 

communication port in the back of the optical reader. 

2. Plug the female end of the optical reader’s serial computer data cable into an 
available communication port on your computer.  Remember the communication port 
in which you plugged the cable. 

3. Plug the optical reader’s power supply cord into the back of the optical reader and 
then into the proper grounded 110 or 220 VAC outlet depending on the voltage 
range of the reader which you ordered. 

Optical Reader Power-Up and U.V. Lamp Start 
Complete the following steps to turn on the optical reader and start the U.V. lamp.  You 
should turn on the optical reader and U.V. lamp at least 30 minutes prior to starting the 
Computer Lane Monitor for Windows program and reading tapes.  The reason for this is 
that it can sometimes take longer to go through the calibration and warm-up processes 
if you start using the Computer Lane Monitor for Windows program immediately after 
turning on the optical reader and U.V. lamp. 

Powering-up the optical reader and starting the U.V. lamp 
1. Turn on the Optical Reader power switch located on the back panel.  See Figure 10 

on page 11 in the Main Operator Manual.  The switch is marked with an “I” for ON 
and “O” for OFF. 

2. Turn on the U.V. lamp by pressing the “U.V. Start” switch on the front panel until the 
amber indicator light remains on, then release the switch.  The light will stay on 
indicating the proper function of the U.V. lamp. 

Note: Do not be alarmed if the U.V. lamp “starts” by itself when the power switch is 
activated.  This sometimes happens if the bulb is warm. 
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Starting Computer Lane Monitor for Windows Program 
Complete the following steps each time you want to use the Computer Lane Monitor for 
Windows program. 

Starting Computer Lane Monitor for Windows  
1. Start Windows. 

2. Double-click on the Computer Lane Monitor for Windows group box. 

3. Double-click on the Computer Lane Monitor for Windows icon to start the program. 

  

4. Click OK on the Brunswick Computer Lane Monitor window. 

 

Note: If you have not installed or are not using an optical reader, you can still use 
Computer Lane Monitor for Windows to view data from past tape data records. If 
you do not have an optical reader connected to the computer you are working 
on, the message “No Tape Reader Detected” is displayed in the lower left corner 
of the program window. 
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Using Computer Lane Monitor for Windows for the First Time 
The following steps need to be done only the first time you use Computer Lane Monitor 
for Windows.  These instructions allow you to configure the optical reader for the 
Computer Lane Monitor for Windows program.  You do not need to repeat these steps 
unless you change the communication port in which the optical reader is connected to 
your computer. 

Using Computer Lane Monitor for Windows for the First Time 
1. Start Windows. 

2. Double-click on the Computer Lane Monitor for Windows group box. 

3. Double-click on the Computer Lane Monitor for Windows icon to start the program. 

4. The first time you run Computer Lane Monitor for Windows, a message box tells you 
that no communications port has been set.  Click OK to acknowledge this message, 
and the Configure Communications dialog box appears.  

5. In the Configure Communications dialog box, select the communication port in which 
you plugged the serial communication data cable, and click OK.  If you do not have a 
tape reader attached to your computer, select None. 

 

6. A status bar is located in the lower left hand corner of the display screen.  When the 
correct communication port is selected, the status should progress from “No Tape 
Reader Detected” to “Tape Reader Connected”.  If the status bar remains on “No 
Tape Reader Detected”, try selecting another communication port and/or switch the 
serial cable to another port on the computer.  Make sure that the optical reader 
power is on and the cable connections are secure. 
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Operation of the Optical Reader 
There are four steps you complete to read tapes with the Computer Lane Monitor for 
Windows program and an optical reader: 

• Warm-up check 

• Calibrate 

• Create a header 

• Read the tape 

Warm-Up Check 
The Warm-Up check monitors the U.V. lamp at the start of the Computer Lane Monitor  
program to make sure that it has stabilized enough to allow accurate calibration and 
reading of sample tapes.  The Warm-Up Check is automatically started each time the 
program is started until the Warm-Up Check is completed or bypassed. 

 

The status of the Warm-Up Check is displayed in the lower left corner of the computer 
display with a bar graph just to the right of the status box.  After the status box indicates 
that the tape reader is connected and the U.V. bulb is on, the system starts an express 
warm-up check.  If the optical reader and U.V. bulb is turned on before the Computer 
Lane Monitor program is started and is sufficiently stable, the express warm-up check 
will progress to 100% in a few minutes.  
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The express warm-up check time varies depending on the ambient temperature, storage 
temperature, age of the U.V. source tube, and the stability of the power supply.  If the 
optical reader is not sufficiently stabilized, the express check will stop at the appropriate 
level and switch to the normal warm-up mode.  In the normal warm-up mode, the 
system should take three minutes to advance to the next 10% level.  This should allow 
you to predict when the unit will reach the 100% level.  All menu options other than 
Calibration and Read Tape can be selected while the reader is warming up.  A status 
box message “Tape Reader Ready to Calibrate” is displayed when the warm-up check 
is complete. 

Tip: For minimum waiting, turn on the U.V. lamp an hour before use.  The Warm-Up 
Check can then be complete in only a few minutes. 

Two warm-up options are available from the Tape Reader menu.  “Bypass” allows you 
to skip the warm-up check to temporarily calibrate the reader and take a quick tape 
reading.  If the reader is not sufficiently warmed up and stable, this option may result in 
frequent recalibration or inaccurate tape readings. 

“Restart” allows you to restart the warm-up check after the Bypass option or at any other 
time when the warm-up check does not seem to be progressing normally.  Select these 
menu options as follows: 

Restarting the warm-up process 
1. From the Tape Reader menu, select Warm-up.   

2. From the Warm-up command, select Restart.  The express warm-up check begins 
automatically.  When the process is complete, the status bar in the lower left corner 
reads “Tape Reader Ready To Calibrate”. 

Bypassing the warm-up process  
1. From the Tape Reader menu, select Warm-up. 

2. From the Warm-up command, select Bypass.  The warm-up process is skipped. 

Note: While the express warm-up check is running, the responsiveness of other 
features of Computer Lane Monitor for Windows and other applications my 
be slower.  Once the express warm-up check if completed, the 
responsiveness should return. 

Calibrating 
Before you can read tapes with an optical reader, you must calibrate.  Calibrating is a 
process in which you adjust the optical reader with calibration strips of a known value.  
This ensures the optical reader’s accuracy.  There are two types of calibrations: 
standard and short. 

Your calibration kit includes three calibration strips.  You should record the date on each 
calibration strip the first time you use them.  You should replace each strip every four 
months.  Always keep the calibration strips in an envelop when you are not using them.  
Exposure to direct sunlight is harmful to the strips and can result in inaccurate 
calibrations. 
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Standard Calibration 
You must calibrate your optical reader the first time you run the Computer Lane Monitor 
for Windows program using the standard calibration.  You use three calibration tape 
strips to complete the standard calibration.  Each strip has a labeled value for a certain 
amount of oil on the strip.  The three values from the three strips creates a current 
calibration value.  When you read your actual lane tapes, the Computer Lane Monitor for 
Windows program and optical reader calculate the amount of oil on the tape sample in 
“units” of oil based on the current calibration value.  

Standard calibration is more accurate than the short calibration.  It verifies that all three 
strips are within the calibration range.  The Computer Lane Monitor for Windows 
program prompts you when you must complete the standard calibration again.  This 
usually occurs when the internal temperature of the optical reader changes. 

The best accuracy is obtained when the tape samples are read soon after the reader is 
calibrated.  For this reason, it is recommended that at least a short calibration be 
conducted every hour while reading tape samples. 

Calibrating your optical reader using the standard calibration 
1. Click on the Calibrate button, or from the Tape Reader menu, select Calibrate. 

2. The Calibrate command has two options, select Standard. 

3. Insert the first calibration strip into the “Tape In” slot until the label end is flush with 
the front edge of the “Tape In” guide as shown. 

Insertion of the Calibration Strip 

Make sure the tape is flush with the front edge of the Tape In slot. 
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4. Click the OK button while holding the calibration strip in the reader for 5 seconds. 

  

5. Type in the value printed on the label of the calibration strip, and click OK. 

  

6. When prompted to do so, insert the second calibration strip in the optical reader, and 
click OK.  Leave the strip in the optical reader until you are prompted to enter the 
label value. 

7. Enter the value on the calibration strip, and click OK.  

8. When prompted to do so, insert the third calibration strip in the optical reader, and 
click OK.  (Same as Step 6.) 

9. Enter the value on the calibration strip, and click OK.  

10. If the calibration process was not successful, repeat the standard calibration, making 
sure to enter the correct label values. 

Short Calibration 
The short calibration option requires only one calibration strip.  This is a time saving 
option which is useful when the optical reader is fully warmed up and the calibration strip 
is known to be accurate.  If the short calibration results in a calibration value that is 
considerably different than the previous value, the system will prompt you to use the 
standard calibration. 

Calibrating your optical reader using the short calibration 
1. Click on the Calibrate button, or from the Tape Reader menu, select Calibrate. 

2. The Calibrate command has two options, select Short. 

3. Insert the calibration strip in the optical reader, and click OK.  Leave the strip in the 
optical reader until you are prompted to enter the label value. 

4. Enter the value on the calibration strip, and click OK.   

5. If the calibration was not successful, select the standard calibration. 
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Entering the Tape Header Data 
A header identifies specific information about each tape data record and is used when 
you select specific records to view in the 2-D tape graph or 3-D lane graph.  You must 
enter this information to save a tape data record.   

Header information includes: 

• The lane number of the lane for which the tape is read.  

• The distance from the foul line in feet for which the tape reading begins. 

• The date of the tape data record. 

• The establishment’s name for which the tape is read. 

• The number of lines bowled since the lane was last conditioned. 

• The first and last name of the person completing the tape reading. 

• The time of the reading. 

• Any comments about the tape data record. 

You can enter header information before or after you read a tape.  However, you cannot 
save a tape data record until you enter a header.  It is recommended that you enter the 
tape header information before reading each tape sample. 

• If you select to read a tape before you enter header information, you are prompted to 
enter the header information after you read the tape, when you attempt to read 
another tape, or close the Computer Lane Monitor for Windows program. 

 

Entering header information 
1. Click on the Tape Header button. 

2. In the Lane Number field, enter the number of the lane for which you want to read a 
tape, and press Tab. 
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3. In the Distance From Foul Line field, enter the number of feet from the foul line the 
oil starts to appear on the tape being read, and press Tab. 

4. In the Date field, enter the date that reading is taking place if it is different from the 
displayed date, and press Tab.  Use the Backspace, delete and arrow keys to edit 
the displayed information fields. 

5. In the Establishment Name field, enter the establishment’s name for which you are 
reading a tape if it is different from the displayed name, and press Tab. 

6. In the Approximate Number of Lines Bowled Since Last Conditioned field, enter the 
number of lines bowled since the last time the lane was conditioned, and press Tab. 

7. In the First Name field, enter the first name of the person taking the reading, and 
press Tab. 

8. In the Last Name field, enter the person’s last name, and press Tab. 

9. In the Time field, enter the time of the reading. 

10. In the Memo field, enter any comments such as the type of oil, pattern, or any other 
desired information. 

11. Click OK to save the header information and start reading a tape.   

If you enter the header before reading a tape, Computer Lane Monitor for Windows will 
save the information with the next tape read.  If you are not ready to read a tape, you 
can select Cancel.  However, if you select Cancel, you must re-enter the header 
information for the lane. 

Reading Tapes 
Select the “Read Tape” option to read and display the value of a new tape sample.  
There are two options with the “Read Tape” menu.  Use the “Automatic” option if you 
have the proper lane edge marker as explained on page 12 of the Main Operator 
Manual.  Otherwise, use the “Manual” option.   

The “AUTOMATIC” option will automatically control the tape drive roller motor to position 
the tape and advance it while it reads the entire tape length.  The “MANUAL” option 
allows you to manually position the tape for the tape zero reading and the start of the 
board #2 before the reader automatically reads and graphs the entire tape length. 

Caution: Make sure there is no tape sample already in the Optical Reader when you 
select a “Read Tape” option.  The Reader takes an empty slot reading to 
check the calibration before each tape sample is read. 
 
The program prompts you if the previous tape sample data was not saved and 
gives you the option to save it.  If the previous tape data is not saved, the 
information is lost as the new tape sample data is loaded into the Current 
Tape Read graph. 

Note: If you have not read and followed the instructions on Sample Tape Preparation 
for Optical Reader, return to page 12 of the Main Operator Manual.  Make sure 
that the tape sample has a straight 6” or longer leader with the recommended 
white lane edge marker. 
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In either of the two tape read options, the status bar in the lower left corner of the 
display screen prompts you through the tape read process. 

As the tape is being read, the data is displayed in a 2-D tape graph with the digital 
reading in units of oil listed in a column on the right side of the screen.  The system 
prompts you to save the tape sample record if the information displayed in the tape 
header and graph are correct. 

“Read Tape” Option - Automatic 
The automatic option allows the optical reader to control the tape when you insert it in 
the Tape In slot to be read.  The optical reader’s tape drive roller motor positions the 
tape and advances it while it reads the entire length of the tape.   

Automatically Reading a Tape 
1. Click on the Read Tape button, or from the Tape Reader menu, select Read Tape. 

2. The Read Tape command has two options, select Automatic. 

3. If you have not already entered the tape header information, you will be prompted to 
enter it or cancel. 

4. Insert a sample tape into the “Tape In” slot of the Optical Reader.  The automatic 
tape drive motor will not start until you have inserted the tape sample leader into the 
“Tape In” slot of the Optical Reader. 

5. After the tape drive motor starts, continue to insert the sample tape further 
into the slot until it contacts the drive rollers and is pulled in by itself.  The 
tape will slowly advance until it finds the lane edge marker.  Then it will reverse to 
take a zero reading from the leader before it advances to quickly read the entire tape 
length. 

Tip: Place a pencil or pen through the center of the tape sample roll to allow it to 
unroll without twisting before it enters the “Tape In” slot.  For best results, 
grasp the front end of the tape as it exits the rear opening of the Reader and 
watch for a steady a tape flow. 

Caution: If the sample tape becomes jammed in the Optical Reader while it is 
being read, IMMEDIATELY STOP THE TAPE READ OPERATION BY 
CLICKING THE “Stop Tape Reader” BUTTON ON THE STATUS BAR, 
OR TURNING OFF THE POWER TO THE READER!  Refer to the 
“Clearing a Tape Jam” section in the Service section of the Main 
Operator Manual. 
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Note: If the Optical Reader cannot find the lane edge marker to automatically 
position the sample tape, or if the lane edge marker is covering part of the 
second board, you will need to use the “Manual” tape positioning explained in 
the following set of steps.  You will need to clear the tape from the Reader by 
selecting the “Move Tape” option from the “Tape Reader” menu BEFORE 
selecting the “Manual” option of the “Read Tape”. 

6. The lane dressing analysis 2-D graph will be automatically displayed as the end of 
the tape sample exits the Reader.  The digital units of oil for each board position will 
be displayed in a column on the right side of the display screen. 

7. You are prompted to save the current tape data. 
Select Yes if you want to save the tape data record for later viewing or reference. 
OR 
Select No if you do not want to save the tape data record. 

Note: If the tape header information is not correct, do not save the tape data 
record.  Make the correction by selecting the Tape Header and editing.  Then 
save the tape sample record by selecting the “Save Tape” option from the 
File menu. 
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“Read Tape” Option - Manual 
The “MANUAL” option of the “Read Tape” program requires the operator to manually 
position the tape on the leader to take the zero reading then manually position the tape 
at the start of the second board (10-pin side).  The program is then started to 
automatically read and graph the entire tape length.  This option should be used if the 
sample tape does not contain the recommended one-inch square, white lane edge 
marker or if the tape leader is less than 6” long.  The “Manual” option is may not be as 
accurate or repeatable as the “Automatic” option of the “Read Tape” program because 
of possible variations in the tape positioning during the Zero Reading and slight shift of 
the lane edge and board readings.  The “Manual” option is useful if the tape sample is in 
poor condition and the tape leader needs extra care while feeding it into the tape slot. 

Manually Reading a Tape 
1. Mark two lines on the sample tape as shown in the figure below.  The first line 

should be 3-1/2” after the 10-pin lane edge with the second line 5-1/2” after the 10-
pin lane edge.  The figure below is shown full scale and can be used as a guide for 
marking a tape. 

Preparing a Tape for Manual Read 

2. Click on the Read Tape button, or from the Tape Reader menu, select Read Tape. 

3. The Read Tape command has two options, select Manual. 

4. Insert the sample tape into the “Tape In” slot of the Optical Reader.  With a normal 
sample tape with a 6” leader, the tape positioning is done by inserting the tape until it 
contacts the rollers. 

5. Click on the “Advance .21” button to cause the reader tape drive motor to engage 
the front of the tape sample.  Repeat clicking the “Advance .21” button to move the 
tape into the reader until the first marked line (3-1/2” after the 10-pin lane edge) is 
flush with the front edge of the “Tape In” guide. 

10-pin
LANE
EDGE

First mark for
Zero Reading

Second mark for
start of second
board reading

3-1/2"

5-1/2"

SHOWN FULL SCALE

3-3/4"  to 10" leader
Un-oiled section of tape

 



 

Page  20 Computer Lane Monitor for Windows 

Note:  You can also click on the Advance .01 button to move the tape forward 
through the optical reader in smaller increments.  The Reverse .21 and 
Reverse .01 buttons move the tape backwards. 

 

6. Click on the Take Zero Tape Reading button to the tape zero reading.  The reader 
has now adjusted for the un-oiled tape leader and will now display units of oil as the 
tape sample is advanced or reversed. 

Note: If the sample tape leader is shorter than 6”, the leader may not contact the 
drive rollers and will have to be held on the 3-1/2” line by hand while the Tape 
Zero Reading button is clicked. 

7. Click on the “Advance .21” button until the second marked line (5-1/2” after the 10-
pin lane edge) nears the front edge of the “Tape In” guide.  Use the “Advance .01”, 
“Reverse .01”, and “Reverse .21” until the second line is exactly flush with the front 
edge of the guide. 

Note: If the 10-pin lane edge was not clearly marked or if the lane edge marker is 
covered by part of the second board, the tape can manually be positioned by 
noting the units of oil of the tape reading on the screen as the tape is 
advanced.  The lane edge should be the point where the reading starts to 
increase noticeably above zero.  (Advance ~1” further to the start of the 
second board.)  A white lane edge marker will cause a very high reading.  
Position the tape just beyond these high readings where the values are 
normal.  Because this procedure involves some estimation as to where the 
second board starts, it may result in readings which are slightly shifted from 
the true board positions. 

8. Click on the Start Reading Tape button.  The optical reader takes over to allow 
the reader to read the entire tape just as previously described in the steps for 
Automatically Reading a Tape. 



 

Computer Lane Monitor for Windows Page  21 

9. If the tape sample becomes jammed in the optical reader, click on the “Stop 
Tape Reader” button as explained in the “Read Tape” Option - Automatic section 
of this manual. 
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Viewing Stored Tape Data 
Each time a tape reading is saved, it creates another tape data record that is stored in 
the current database.  You can view stored tape data records in the currently selected 
database in two different graphical formats: a 2-D tape graph or a 3-D lane graph.  You 
cannot change stored tape data for a 2-D tape graph or a 3-D lane graph record.  If there 
are errors in a tape data record, such as the wrong lane number or wrong center, you 
must re-enter the header information and reread the tape. 

For either a 2-D tape graph or a 3-D lane graph, you can select to show or hide the 
Button Bar, Tape Header or Graph Toolbar.  Hiding some or all of these items allows 
you to display a larger graph.  The Graph Toolbar allows you to customize how a graph 
is displayed. 

To display or hide the Button Bar, Tape Header or Graph Toolbar 
 From the Configure menu, select Show Button Bar, Show Tape Header or Show 

Graph Toolbar, as desired.  The selected item is then displayed.  

 OR 

 From the Configure menu, select Hide Button Bar, Hide Tape Header or Hide Graph 
Toolbar, as desired.  The selected item is then hidden from view. 

Viewing a 2-D Tape Graph 
When you select to view a 2-D tape graph, the screen displays lane statistics in a  
two-dimensional line graph.  The line graph displays the board number legend on the 
bottom of the graph and the units of oil legend along the left side of the graph. 

You use the 2-D tape graph to see how oil is distributed across the lane at a given 
distance from the foul line.  The digital units of oil are listed for each board position in a 
column on the right side of the display. 

You can view up to five tape data records overlayed in a single 2-D tape graph.  All the 
records you select display in different colors on the graph so that you can compare the 
tape data records.  The graph’s header information provides a legend so that you can 
identify each of the records. 

1. Click the 2-D tape graph button.  The Select Data to Graph dialog box is displayed. 

2. Select the tape data record(s) you want to view, and click OK.  Selected records are 
highlighted.  Clicking on a record a second time deselects the record and remove 
the highlighting. 

Note:  The tape data records that are listed depend on the database file that you 
opened when you first started using Computer Lane Monitor for Windows.  To 
view records in another database file, use the File menu’s Database|Select 
Database command to open the other database file and repeat Steps 1 and 2. 

Note: The memo field can be lengthened in this dialog box to display more of its 
contents by clicking and holding the the mouse cursor on the right end of the 
Memo Title range and dragging it further to the right before releasing. 
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After you click OK, the window displays the selected record(s) in a 2-D tape graph.  
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Viewing a 3-D Lane Graph 
The 3-D lane graph displays multiple tape-read data for one lane at a time.  When you 
select to view a 3-D lane graph, the screen displays lane statistics in a three-
dimensional graph.   The 3-D Lane Graph is useful only when all selected records are 
from the same lane condition at different distances. 

The Computer Lane Monitor for Windows program assumes that the distribution of oil 
was the same from the foul line to the distance that the first tape sample was recorded.  
It then averages the amount of oil on each board between each of the next tape 
samples recorded to show the entire oil pattern for that lane.  The 3-D graph becomes 
more accurate by recording more tape samples along the distance of the lane.  The 
distance of each tape sample from the foul line is displayed on the 3-D graph. 

Colors identify different amounts of oil on the lane in this graph.  Use the legend on the 
right side of the window to see how many units of oil each color represents. 

You can select the layout of a 3-D lane graph.  There are a number of different layouts 
you can view.  Each of the following graph layouts displays the same information, just in 
different perspectives. 

• End View—Displays the graph as if you were looking at the lane from the pinsetter 
end. 

• Side View—Displays the graph as if you were looking at the lane from the side. 

• Overhead View—Displays the graph as if you were looking at the lane from a top 
view. 

• Custom View—Displays the graph in a format that you specify.  See instructions for 
Changing a lane graph’s angle on page 26. 

Viewing a 3-D lane graph 

1. Select the 3-D lane graph button. 

2. Click on the graph layout you want to view. 

  

3. In the Select Data to Graph dialog box, select the lane record that you want to view 
by using the following “filter” method: 
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 The three drop-boxes at the top of the dialog box help you quickly select a set of 
tape records to display for the desired center, sorted by the selected date and lane 
number.  To use the drop-boxes, click on the down arrow button to the right of the 
desired drop-box.  This will show all available options under that heading.  Make 
your selection from the list of items shown by clicking to highlight the desired Center 
Name, Date and Lane Number. 

• Select Center Name from the options in the drop-box first. 

• Select Date next from the options in the drop-box (filtered for the selected Center 
Name).   

• Select Lane Number last from the options in the drop-box (filtered for the Center 
Name and Date). 

• If you want to view the filtered header information for each tape data record for 
the selected Center Name, Date and Lane Number, click the View Records 
button.  (If you want to view the graph without viewing the records, proceed to 
step 5 below). All records that are specific to the information entered in the 
Center Name, Date, and Lane Number fields are displayed.  Individual tape 
records cannot be selected by using this “filter” method.  See step 4 below. 
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4. If you want to select individual tape data records from a list of all your centers, for all 
dates, and all lane numbers, click the Show All Records button.  All the records in 
the database file you currently have opened will be displayed in the dialog box.  Now 
you can select individual tapes for the 3-D Lane Graph by clicking on the desired 
tape records to highlight them similar to the 2-D graph selection process.  This is 
useful if you have a number of tape data records from the same lane but from 
different times on the same day.  Select the tape records from the same lane 
condition (i.e., morning reading or evening reading).  Also, this allows you to select 
any tape record which may have been entered with the wrong date, lane number, or 
center name.  There is no limit to the number of tape records you may select, but the 
3-D graph will only be useful if all tape records are from the same lane number at 
different distances from the foul line. 

5. Click on the Show Graph button to view data in the selected 3-D layout. 

Custom View and Changing a Lane Graph Angle 
If you select Custom View from the Select 3D View dialog box, the 3D View Properties 
dialog box is displayed.  When you are already viewing a 3D graph, you can also access 
this dialog box from the Configure menu by selecting 3-D Angle.  To use the dialog box, 
either: 

Enter the desired values in the X Angle and Y Angle fields, and click OK. 
OR 
You can change the X angle by clicking on the red dot.  Hold down the mouse button 
and drag the dot along the red line.  You can change the Y angle by clicking on the blue 
dot.  Hold down the mouse button and drag the dot along the blue line.  Click OK when 
the dots are at the angles you want to view.  Values in the X Angle and Y Angle fields 
change to represent the angle of the red and blue dots. 
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Adding a Comment to the 3-D Lane Graph 

 

 
The header of the 3-D Lane Graph includes the comment field from the tape sample 
nearest the foul line.  You may also add a general comment regarding the entire graph 
by clicking in the Graph Description edit box.  A text cursor then becomes active, and 
you may type in the desired description.  This information will be printed, but will not be 
saved after the 3-D Lane Graph is changed or closed.  

Selecting a Graph to View 
The most recent 3D Lane Graph, 2D Tape Graph and Current Tape Read Graph are 
kept in memory while Computer Lane Monitor for Windows is running.  To select a 
graph to view, click on the Window menu, then select the desired graph from the menu 
list.  The menu item for the currently viewed graph is check-marked.  If a graph is active, 
its menu item will be enabled, otherwise it will be disabled. 

Note: You can speed up graphics performance by closing or minimizing the 3D Lane 
Graph window when not in use.  Leaving the 3D Lane Graph window in the 
maximized in the background can cause a slowdown in graphics performance. 

Printing a Graph 
You can print any of the Current Tape Read, 2-D tape graph or 3-D lane graphs. 

1. Display the graph you want to view. 

2. From the File menu, select Print. 

For the best printed output, you should select the landscape mode for your printer, if 
available.  This can be done by selecting the File | Printer Setup menu option. 

Note: The 3D Lane Graph can take several minutes to print, depending on the type of 
printer you have.  Particularly with color printers, due to the Windows system 
resources required to print, you may wish to close other applications.  Printing 
may also slow down system responsiveness.  If you encounter other printer 
errors, such as printer overrun, check that the printer configuration is correct and 
that the printer memory is sufficient. 

Enter Graph Description Here 
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Using the Graph Toolbar 
The Graph Toolbar permits the user to access several commands and features for 
customizing the graph display.  This guide does not teach you how to use the graph 
toolbar.  In fact, the tool bar is intentionally not shown unless selected from the 
Configure menu.  It is recommended that only experienced Windows users utilize the 
graph toolbar since some of the commands do not apply to the Computer Lane Monitor 
graphs and may cause errors.  The two graph toolbar commands which may be useful 
with Computer Lane Monitor graphs are as follows: 

 This button is most useful with the 2-D Tape Graph.  It changes the ribbon type 
tape graph into a true line graph for detail comparisons of more than one tape record.  
Click on this button to switch between the ribbon and line type graphs. 

 

 This button allows the user to select a region in the graph to zoom in.  It is useful 
to enlarge a section of the 3D Lane Graph.  Click once on the zoom button, then move 
the mouse to one corner of an area to enlarge. Click the left mouse button and hold it 
down.  You can then move the mouse to select a rectangular area to zoom into.   
Release the mouse button once you have defined the desired rectangle.  The graph 
display will then zoom in and display only the selected area.  Click the left mouse button 
again to return to the original graph view. 
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Working with Database Files and Records 
The Computer Lane Monitor for Windows program is initially set up with a database 
named SAMPLES.mdb in the CLMWIN subdirectory.  All saved tape data records are 
stored into this database and all viewing commands will select tape data records out of 
this database until another database file is created and selected.   

The following sections explain how to select a different database, how to create a new 
database, and how to delete an entire database.  The sections also explain how to copy 
one or more tape data records from one database file to another, how to delete one or 
more tape data records within a database, and how to import tape data records from a 
Computer Lane Monitor DOS database file into a Windows database file. 

Selecting a Database File 
The Computer Lane Monitor for Windows program allows you to open only one database 
file at a time.  The name of this “current” database is displayed to the right of the button 
bar.  All saved tape data records are stored into this database and all viewing commands 
select tape data records from this database until another database file is selected.  The 
following steps explain how to select or open a different database file. 

Opening a database file 
1. From the File menu, select the Database command.  Then, from the Database 

menu, select Select Database.  The Open Database dialog box is displayed. 

  

2. A list of database files is displayed in the list below the File Name field.  Select the 
database file you want to open. 

Note:  If you do not see the database file that you want to open, you can change the 
Drive: field to open a file that was saved to a different drive, such as to a floppy disk 
in Drive A.  You can also use the Directories list to find a database file in a different 
subdirectory.  Click on at the top of the Directories list to see all the 
directories in that drive.  These are basic Windows commands.  See your Windows 
User Guide if you need more help opening files in Windows. 

3. Click OK after the desired filename appears in the upper left box. 
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Creating a New Database File 
You can create as many database files as you want.  For example, you can create a 
different database for a different center or a different time period such as at the start of 
a new season.   

Creating a new database file 
1. From the File menu, select the Database command.  Then, from the Database menu, 

select Create New Database.  The Create New Database dialog box is displayed. 

  

2. In the File Name field, type the name of your new database file.  There are some 
points to remember when naming a database file: 

• Do not use a space or “/” in the database filename. 

• Do not use more than eight letters or numbers in the filename. 

• All database files must end with the “.MDB” extension.  You can include this in 
the filename if you want; otherwise, it is automatically added to the end of your 
filename.  Do not use other file extensions. 

Note:  You can change the Drive: field to save a new database file to a different 
drive, such as to a floppy disk in Drive A.  You can also use the Directories list to 
save a new database file to a different subdirectory.  These are basic Windows 
commands.  See your Windows User Guide if you need more help saving files in 
Windows. 

3. Click OK. 
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Deleting a Database File 
You can delete a database file if you no longer need the tape data records that were 
stored in the file. 

Deleting a database file 
1. From the File menu, select the Database command.  Then, from the Database 

menu, select Delete Database.  The Delete Database dialog box is displayed. 

 

2. Click on the database filename in the list displayed on the right side of the dialog 
box.  The selected database file is displayed in the Selected Database field.  If the 
database file is not listed, change the drive and subdirectories in the left side of the 
dialog box. 

3. Click OK. 

4. A warning message is displayed.  Select OK if you are sure that you want to delete 
the database file.  If you do not want to delete the file, select Cancel. 

Note:  You cannot delete the current database.  It is necessary to close any graph 
that is displayed from the database before you can delete it.  It is suggested 
to select a current database which will not be deleted and make sure any 
displayed graph is from that current database. 
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Copying Tape Data Records 
You can copy tape data records from one database file to another. 

Copying tape data records 
1. From the File menu, select the Database command.  Then, from the Database 

menu, select Copy Records.  The Copy Records dialog box is displayed. 

  

2. In the list on the right side of the dialog box, just below the Copy records from field, 
select the database file that contains the records you want to copy.  The name of the 
selected database is displayed in the Copy records from field. 

3. In the list on the right side of the dialog box, just below the Copy records to field, 
select the database file in which you want to copy database records.  The name of 
the selected database is displayed in the Copy records to field. 

4. Click OK.  The Select Records to Copy dialog box is displayed.   
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5. Select the tape data records that you want to copy, and click Copy Selected 
Records. 
OR 
Click the Copy All Records button if you want to copy all the tape data records. 

All the records are copied into the selected database.  Use the Select Database 
command to open the database file in which you copied the records. 
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Deleting Tape Data Records 
You can delete old tape data records from a database file without deleting the whole 
database file itself. 

Deleting tape data records 
1. From the File menu, select the Database command.  Then, from the Database 

menu, select Delete Records.  The Delete Records dialog box is displayed. 

  

2. Click on the database filename in the list displayed on the right side of the dialog box 
that contains the records you want to delete.  The selected database file is displayed 
in the Delete records from field.  If the database file is not listed, change the drive 
and subdirectories in the left side of the dialog box. 

3. Click OK.  The Select Records to Delete dialog box is displayed. 
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4. Select the tape data records that you want to delete, and click Delete Selected 
Records. 
OR 
Click the Delete All Records button if you want to delete all the tape data records. 

The records are removed from the database file. 

Repairing a Database 
You can restore any database file which is suspected of being corrupt. 

Repairing a database 
1. From the File menu, select the Database command.  Then, from the Database 

menu, select Repair Database.  The Repair Database dialog box is displayed. 

2. A list of database files is displayed in the list below the File Name field.  Select the 
database file you want to repair. 

3. Click OK. 

Importing DOS Data 
You can import data stored in other file formats into an *.MDB file format so that the 
Computer Lane Monitor for Windows program can understand the data.  For example, if 
you used Computer Lane Monitor for DOS, you can import all the tape data records 
taken with that software into the Computer Lane Monitor for Windows program. 

Importing DOS data 
1. From the File menu, select the Database command.  Then, from the Database 

menu, select Import DOS Data.  The Import DOS Data dialog box is displayed.      
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To change the import from or to drives, use the drop-boxes to select the desired disk 
drive.  To navigate through the directories, click on the topmost [Drive]:\ folder icon 
to display the root-level directory on the selected disk drive. For example, double 
clicking on the line in the “Importing from” section will list the subdirectories 
on the C: drive.  Then double clicking on the “lm” subdirectory will list the database 
files available for importing in the file list box in the upper-center portion of the dialog 
box.  

2. In the file list in the upper center of the dialog box, just below the Importing from 
field, select the database file (with a .dbf extension) that contains the data you want 
to import.  The name of the selected database is displayed in the Importing from 
field. 

3. In the list in the lower center of the dialog box, just below the Importing to field, 
select the destination database file (with a .mdb extension) in which you want to 
receive the data.  The name of the selected database is displayed in the Importing to 
field. 

4. Click OK. 
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Troubleshooting 
PROBLEM NO. 1: LANE RECORDER CARRIAGES DO NOT SLIDE FREELY. 

CAUSE A: Dirty track or carriage. 
SOLUTION A: Clean track or carriage. 
 
CAUSE B: Bent parts. 
SOLUTION B: Replace or have repaired by competent machine shop. 
 
CAUTION: The hard coating on aluminum parts is essential to proper sliding. 
 
PROBLEM NO. 2: SAMPLE TAPES MADE WITH THE LANE RECORDER 

REPEATEDLY COME OUT MISMATCHED, WRINKLED, OR 
DISTORTED. 

CAUSE A: Tape rolls not seated against the shoulder of tape hub. 
SOLUTION A: Reposition tape roll on tape hub. 
 
CAUSE B: Tape roll distorted so that outer tape is out of line with core. 
SOLUTION B: Use a new roll of tape. 
 
CAUSE C: Tape core loose on hub. 
SOLUTION C: Because tape cores vary in size, the hub may have to be built up 

with tape to get a tight fit. 
 

CAUSE D: Shoulder bolts on carriages loose or bent. 
SOLUTION D: Use straight carriage bolts, properly tightened. 

 
CAUSE E: Push rod held at wrong angle, causing carriages to lift or misguide. 
SOLUTION E: Push rod at recommended 45 degree angle. 

 
CAUSE F: Channel track aasembly was moved between the time that the first 

strip of tape was applied by the applicator carriage and the time 
that the second lifter carriage was pushed across to match the two 
tape strips. 

SOLUTION F: Make sure that the channel track assembly is not moved on the 
lane while making tape samples. 

 
PROBLEM NO. 3: TAPE STICKS TO LANE RECORDER END PLATES. 

CAUSE A: Improper technique in handling carriages. 
SOLUTION A: See "Operation of Lane Recorder" in manual. 
 
CAUSE B: Emery cloth missing. 
SOLUTION B: A 2" x 3" piece is required on the rear plate and a 2" x 5-1/2" piece 

is required on the far plate.  Replace as necessary. 
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PROBLEM NO. 4: U.V. START INDICATOR FAILS TO LIGHT WHEN "U.V. START" 
SWITCH IS DEPRESSED. 

CAUSE A: Optical Reader power is not on. 
SOLUTION A: Make sure Optical Reader is plugged into a live outlet and that the 

power switch is turned ON.  The switch is marked with a "0" and a 
"1".  The "1" is ON. 
 

CAUSE B: Fuse is burned out. 
SOLUTION B: Check the fuse and replace if necessary. See Optical Reader Fuse 

Replacement Procedure. The specified fuse is a 1 Amp 250 Volt 
fast blow fuse. DO NOT USE A LARGER FUSE. 
 

CAUSE C: U.V. Source tube is burned out. 
SOLUTION C: Replace U.V. source tube. See U.V. Source Tube Replacement 

Procedure. 
 
PROBLEM NO. 5: U.V. START INDICATOR LIGHTS WHEN "U.V. START" SWITCH 

IS DEPRESSED, BUT GOES OUT WHEN SWITCH IS RELEASED. 

CAUSE A: "U.V. START" switch not held long enough. 
SOLUTION A: Hold "U.V. START" switch for at least one second before releasing. 

 
CAUSE B: U.V. Source tube is burned out. 
SOLUTION B: Replace U.V. source tube. See U.V. Source Tube Replacement 

Procedure. 
 
PROBLEM NO. 6: COMPUTER SCREEN INDICATES THAT "LANE MONITOR NOT 

FOUND" WHEN PROGRAM SOFTWARE IS RUN OR 
"HARDWARE STATUS FAILURE" IS INDICATED. 

CAUSE A: Optical Reader power or U.V. source tube are not on. 
SOLUTION A: Make sure Optical Reader is plugged into a live outlet and that the 

power switch is turned ON, and U.V. source tube is turned on.  The 
power switch is marked with a "0" and a "1".  The "1" is ON. 

 
CAUSE B: Serial data cable is not properly connected. 
SOLUTION B: Make sure the female end of the serial data cable is plugged into 

the connection on the back panel of the Optical Reader and that 
the male end of the serial data cable is properly connected to the 
serial port of the computer. 
 

CAUSE C: Incorrect serial port set-up or connection. 
SOLUTION C: Move the computer serial data cable to another available serial port 

on the back of the computer or change the serial port set-up from 
the Configure Communications menu.  See section “Using 
Computer Lane Monitor for Windows for the First Time” in the 
online help. 
 

CAUSE D: Serial data cable is damaged. 
SOLUTION D: Replace the serial data cable. 
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PROBLEM NO. 7: LANE READER TAPE DRIVE MOTOR DOES NOT 
AUTOMATICALLY START TO READ A SAMPLE TAPE. 

 
CAUSE A: Optical Reader improperly calibrated. 
SOLUTION A: Repeat the "Calibrate" option and make sure the calibration strip is 

not too old (should be less than four months since first used) and 
that the calibration value of the strip was properly input from the 
keyboard. Use the Manual Tape Read Option if necessary. 

 
PROBLEM NO. 8: SAMPLE TAPE STARTS FEEDING INTO THE OPTICAL 

READER, BUT THE PROGRAM INDICATES THAT THE LANE 
EDGE MARKER CAN'T BE FOUND. 

CAUSE A: Sample tape does not have the proper lane edge marker. 
SOLUTION A: Refer to "Sample Tape Preparation for Optical Reader."  Use the 

Manual Tape Read option is necessary. 
 
PROBLEM NO. 9: SAMPLE TAPE DOES NOT FEED INTO THE OPTICAL READER 

AFTER POSITIONED ON THE LANE EDGE MARKER. 

CAUSE A: Sample tape leader is not long enough. Front of leader becomes 
disengaged from tape drive rollers as tape is reversed to take a 
zero reading ~1" in front of the lane edge marker. 

SOLUTION A: Refer to "Sample Tape Preparation for Optical Reader."  Use the 
Manual Tape Read option is necessary. 

 
PROBLEM NO. 10: SAMPLE TAPE STARTS FEEDING INTO THE OPTICAL 

READER, BUT DOES NOT EXIT THE SLOT IN THE REAR OF 
THE UNIT. 

CAUSE A: Sample tape is jammed inside the Optical Reader.  
SOLUTION A: STOP THE TAPE READ OPERATION IMMEDIATELY BY 

PRESSING THE "ESCAPE" KEY OR TURNING OFF THE 
POWER TO THE OPTICAL READER!  Refer to "Clearing a Tape 
Jam" section of this manual. 

 
PROBLEM NO. 11: THE TAPE DRIVE MOTOR STALLS OR MAKES A RATTLING 

NOISE AS THE SAMPLE TAPE IS BEING READ. 
 
CAUSE A: Excessive wrinkling on sample tape. 
SOLUTION A: Smooth tape sample if possible.  If tape condition is too poor, it will 

not be able to be read by the Lane Monitor. Apply slight tension on 
the tape sample at the rear tape exit side of the Reader. 

 
CAUSE B: Foreign material build up on rollers. 
SOLUTION B: Clean rollers.  Refer to "Optical Reader Roller Cleaning" section of 

this manual. The rollers should be cleaned after approximately 
every 100 tapes, depending on condition of the tapes and other 
operating conditions. 
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PROBLEM NO. 12: THE VALUES OF THE SAMPLE TAPE READINGS ARE 
NEGATIVE. 

CAUSE A: The tape zero reading was taken over the lane edge marker. 
SOLUTION A: Apply very slight tension on the tape sample near the "Tape In" 

side of the Reader to assist tape reverse during tape zero readings.  
Use the Manual Tape Read option if necessary. 

 
PROBLEM NO. 13: COMPUTER SCREEN INDICATES THAT “LANE EDGE MARKER 

IS COVERING PART OF BOARD NO. 2”. 

CAUSE A: Lane edge marker is longer than 1.0 inch. 
SOLUTION A: Use the Manual Tape Read option.  The tape sample may have to 

be advanced into the Optical Reader slightly farther than the normal 
second line to move the lane edge marker out from under the 
sensor.  Note that the lane edge marker normally reads above 20 
units of oil.  Advance the tape sample until the units of oil indicated 
on the display drops from high readings over the lane edge marker 
to normal readings for the second board.  Remember that the 
board reading displayed on the 2-D Tape graph will be shifted 
slightly from the actual lane positions.  The alternate method is to 
follow the Manual Read Tape procedure while aligning the tape 
sample exactly with the first and second lines.  This will result in 
proper board positioning, but the unit of oil value for board no. 2 
may be inaccurate since the lane edge marker is covering part of 
board no. 2. 

 
CAUSE B: Board no.2 actually has more than 20 units of oil, which is 

interpreted by the Computer Lane Monitor as a continuation of the 
lane edge marker. 

SOLUTION B: Use the Manual Tape Read option following the two alignment lines 
(3.5” and 5.5” from the lane edge). 

 
CAUSE C: Wrinkled or mismatched tape samples slipped in rollers or tape 

doubled under itself while reversing, allowing the lane edge marker 
to remain under the sensor instead of board no. 2. 

SOLUTION C: Apply very slight tension on the tape sample near the “Tape In” side 
of the Reader to assist tape reversal process.  Clean rollers and 
use Manual Tape Read option if necessary. 

 
PROBLEM NO. 14: EXPERIENCING FREQUENT PROMPTS TO RECALIBRATE OR 

WARM-UP TIMES ARE LONGER THAN AN HOUR. 

CAUSE A: U.V. Source tube in reaching the end of its useful like and is 
unstable or not up to full intensity. 

SOLUTION A: Replace the U.V. Source tube.  See U.V. Source Tube 
Replacement Procedure. 
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PROBLEM NO. 15: COMPUTER SCREEN INDICATES THAT “Calibration Value is Out 
of Range”. 

CAUSE A: Optical Reader improperly calibrated. 
SOLUTION A: Repeat the “Calibrate” option and make sure the calibration strip is 

not too old (should be less than four months since first used) and 
that the calibration value of the strip was properly input from the 
keyboard.  The upper limit on standard calibrationis 1.6.  Use the 
short calibration until the old calibration strips can be replaced. 

 
CAUSE B: U.V. Source tube is reaching the end of its useful like and is 

unstable or not up to full intensity. 
SOLUTION B: Replace the U.V. Source tube.  See U.V. Source Tube 

Replacement Procedure.  Use the short calibration method until the 
U. V. Source tube can be replaced. 

 
PROBLEM NO. 16: COMPUTER SCREEN INDICATES MEMORY ERROR MESSAGE. 

CAUSE A: Your computer is configured with less than 600K conventional 
memory or less than 4MB total memory. 

SOLUTION A: Reconfigure your conventional memory and add additional memory 
if necessary. 
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